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About This Guide

This guide documents the IRISconsole™ software graphical user interface
for a Silicon Graphics® Indy™ workstation that allows it to control
CHALLENGE/Onyx™ systems. The IRISconsole software is included in the
IRISconsole package, which also includes an IRISconsole ST-1600™
multiplexer, and serial cables.
The Indy workstation communicates with the servers through the ST-1600,
to which each CHALLENGE/Onyx system is connected via a pair of serial
cables. Each ST-1600 has ports for eight or more CHALLENGE/Onyx
systems; additional sets of serial cables are available from Silicon Graphics.
Optionally, an additional ST-1600 can be connected to the Indy to monitor
additional servers.

Audience
This guide is written for system administrators and service personnel who
are responsible for the configurations of two or more CHALLENGE/Onyx
system that the IRISconsole controls and monitors. These persons can use
the IRISconsole software to monitor the attached systems.

Structure of This Document
This guide contains the following chapters and appendixes:
•

Chapter 1, “IRISconsole Features and Capabilities,” introduces
IRISconsole features and describes how IRISconsole works with the
CHALLENGE/Onyx systems. This chapter explains how to use the
IRISconsole security feature.
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•

Chapter 2, “Configuring Sites,” explains how to use the IRISconsole
graphical user interface to set up groups of systems for administration
purposes.

•

Chapter 3, “Administering Sites,” explains how to use the IRISconsole
graphical user interface for administration tasks such as determining
hardware status (voltage, operating temperature, and blower speeds),
and controlling, shutting down, or restarting systems in a site.

•

Appendix A, “Error Messages and Warning Messages,” lists and
explains IRISconsole error and warning messages.

An index completes this guide.

Conventions
These type conventions and symbols are used in this guide:
Italics

Executable names, filenames, IRIX commands, manual or
book titles, new terms, program variables, tools, utilities,
variable command line arguments, variable coordinates,
and variables to be supplied by the user in examples, code,
and syntax statements

Fixed-width type

Error messages, prompts, and onscreen text
Bold fixed-width type

User input, including keyboard keys (printing and
nonprinting); literals supplied by the user in examples,
code, and syntax statements (see also <>)

x

“”

(Double quotation marks) Onscreen menu items and
references in text to document section titles

[]

(Brackets) Surrounding optional syntax statement
arguments

<>

(Angle brackets) Surrounding nonprinting keyboard keys,
for example, <Esc>, <Ctrl-D>

Chapter 1

1.

IRISconsole Features and Capabilities

This chapter introduces the operational features, functions, and capabilities
of the IRISconsole software. It explains
•

using IRISconsole with the ST-1600 and the Indy workstation

•

the IRISconsole graphical user interface

•

IRISconsole security

•

IRISconsole operation

Using IRISconsole With the ST-1600 and the Indy Workstation
The IRISconsole software allows an Indy workstation to control
CHALLENGE/Onyx systems through one or two Silicon Graphics ST-1600
multiplexers. Serial cables supplied with the option connect the Remote
System Control port and the System Console port on each server to the
ST-1600.
IRISconsole includes a security feature that lets you specify administrators
and users who will have access to functionalities of IRISconsole. Also,
certain features of IRISconsole can be accessed remotely using ictelnet, a
version of telnet that works with IRISconsole.
IRISconsole is a local system; the IRISconsole software applies only to
systems that are physically attached to the ST-1600 connected to the Indy
workstation on which the IRISconsole software is running. The IRISconsole
software cannot communicate with another system running IRISconsole to
share access to attached systems.
Cabling the ST-1600 and CHALLENGE/Onyx systems is explained in the
IRISconsole ST-1600 Installation Guide (007-2839-001). Figure 1-1 shows an
example IRISconsole site installation.
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Figure 1-1

2

IRISconsole Site Example

The IRISconsole Graphical User Interface

Hardware requirements for the IRISconsole software are as follows:
•

The 24-bit Indy workstation must have a minimum of 32 MB of
memory and must be running IRIX 5.3. The 20-inch display is strongly
recommended for IRISconsole operation, as are XFS filesystems, for
their decreased recovery time and typically better performance.

•

If one of the attached servers is a CHALLENGE S, or if an attached
CHALLENGE/Onyx system does not have a Remote System Control
port, not all features of the IRISconsole software are available. An
upgrade consisting of an RS-232 plate assembly is available to equip
CHALLENGE L servers that lack this port; contact your service
representative.

•

Only the cables supplied with IRISconsole, and additional cables for
IRISconsole available from Silicon Graphics, are supported for
connecting the CHALLENGE/Onyx systems to the ST-1600. The
IRISconsole ST-1600 Installation Guide describes these cables.

The IRISconsole Graphical User Interface
The IRISconsole graphical user interface (GUI) enables you to set up and
administer sites. A site is a group of workstations, servers, or other systems
that are administered through IRISconsole. You can use the IRISconsole GUI
to
•

set up a site or add or delete the systems in a site

•

display, view, or take control of the console of a system

•

generate a nonmaskable interrupt (NMI), or hardware-reset, or
power-cycle a system

•

view real-time graphs of hardware operating statistics of a system in a
site, such as voltage, operating temperature, and blower speeds; save
the graphs as files and display them

•

set a threshold for operating statistics so that an alarm is activated and
various activities are triggered when the threshold is exceeded

•

view activity logs and other system reports

Chapter 2, “Configuring Sites,” and Chapter 3, “Administering Sites,” in
this guide explain how to set up sites and administer sites, respectively.
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IRISconsole Security
IRISconsole includes security features that use local password protection to
assist administrators in securing IRISconsole and its managed systems from
unauthorized access. When IRISconsole security is turned on, access to
certain operations is controlled. These operations are as follows; some of
these operations are represented by buttons in the site window:
•

adding or deleting sites and systems in the sites (Edit pulldown menu)

•

getting the console (Get Console), viewing the console window of a
system controlled by another user (Spy Console), and taking control of a
system console that another user is currently using (Steal Console)

•

generating a non-maskable interrupt (Generate NMI)

•

hardware reset (HW Reset) and power cycle (Power Cycle)

•

viewing console activity logs (Show Console Logs)

Note: For access to these operations to be controlled, IRISconsole security

must be turned on. Security is on by default.
The IRISconsole software includes functions for setting up and maintaining
administrator and user logins, each with a password. These logins and
passwords are specific to IRISconsole and are independent of system logins
and passwords. You can
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•

determine whether IRISconsole security is off or on

•

add an IRISconsole administrator

•

add an IRISconsole user

•

change the administrator’s or user’s password

•

delete an administrator or user

•

set IRISconsole security off or on

•

view a list of IRISconsole users

IRISconsole Security

Determining Whether IRISconsole Security is Off or On
To determine whether IRISconsole security is on, type
icpass -security get

The software returns off or on.

Adding an IRISconsole Administrator
To add an IRISconsole administrator, type as root
icpass -add icadmin

The window shown in Figure 1-2 appears.

Figure 1-2

Adding an IRISconsole Administrator

Enter the new user’s login and password. Note that they are independent of
that user’s system login and password. Click the Apply button.

Adding an IRISconsole User
To add an IRISconsole user, you must be an IRISconsole administrator. Type
icpass -add icuser

The window shown in Figure 1-4 appears.
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Figure 1-3

Using the IRISconsole Security Window

After you enter your IRISconsole login and password and click the Apply
button, the window shown in Figure 1-4 appears.

Figure 1-4

Adding an IRISconsole User

Enter the new user’s login and password. Note that they are independent of
that user’s system login and password. Click the Apply button.

Changing the Administrator’s Or User’s Password
To change an IRISconsole administrator’s or user’s password, type
icpass -change icuser

or
icpass -change icadmin
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The window shown in Figure 1-5 appears.

Figure 1-5

Changing an IRISconsole Password

Enter the login for the user whose password you want to change. Enter the
user’s old password and new password, and click the Apply button.

Deleting an Administrator or User
To delete an IRISconsole administrator or user, you must be an IRISconsole
administrator. Type
icpass -delete icadmin <icadminlogin>

or
icpass -delete icuser <icuserlogin>

The security window shown in Figure 1-4 appears. After you enter correct
information, a confirmation window appears with the message
Entry deleted from password database
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Setting IRISconsole Security Off or On
To set IRISconsole security on or off, you must be an IRISconsole
administrator. To set IRISconsole security on, type
icpass -security set on

To set IRISconsole security off, type
icpass -security set off

In either case, the security window shown in Figure 1-4 appears. After you
enter correct information, a confirmation window appears with the message
Access Control status changed to ‘ON’

or
Access Control status changed to ‘OFF’

Viewing a List of IRISconsole Users
To view a list of IRISconsole administrators, type
icpass -list icadmin

To view a list of IRISconsole users, type
icpass -list icuser

In each case, IRISconsole prints the path of the password file.

IRISconsole Operation
To use the IRISconsole, follow these steps:
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1.

Make sure the Indy workstation, ST-1600 multiplexer, and
CHALLENGE/Onyx systems to be administered are cabled as
described in the IRISconsole ST-1600 Installation Guide.

2.

Make sure all systems are powered on.

IRISconsole Operation

3.

The IRISconsole security feature is on by default; to check it or toggle it
on or off, follow instructions in “IRISconsole Security,” earlier in this
chapter.

4.

Start the IRISconsole graphical user interface: in an IRIX window, type
/usr/sbin/ic

The IRISconsole GUI main window appears, as shown in Figure 1-6.

Figure 1-6

IRISconsole Graphical User Interface Main Window

To exit the IRISconsole GUI, select “Quit” in the File menu or press
<Ctrl-Q>.
Chapter 2, “Configuring Sites,” gives instructions for setting up sites;
Chapter 3, “Administering Sites,” has complete information on using
IRISconsole for administering sites.
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2.

Configuring Sites

This chapter explains how to use the IRISconsole graphical user interface
(GUI) to set up a site, configure a site, edit a site configuration, add a system
to a site, or delete a site configuration. Facilities for accomplishing these
tasks are accessed through the IRISconsole GUI main window. Figure 2-1
shows an IRISconsole main window with one site configured.

Figure 2-1

IRISconsole Main Window With One Site Configuration

Note: IRISconsole is a local system; the IRISconsole software applies only to

systems that are physically attached to the ST-1600 connected to the Indy
workstation on which the IRISconsole software is running. The IRISconsole
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software cannot communicate with another system running IRISconsole to
share access to attached systems.
Setting up a site entails
•

using IRISconsole to add a site

•

checking the ST-1600 SCSI ID number and serial ports

•

adding systems to a site

Adding a Site
To set up an IRISconsole site, follow these steps:
1.

In the Edit menu, select “Add New Site...” The Change IRISconsole
Config dialog box appears, as shown in Figure 2-2.

Figure 2-2

Change IRISconsole Config Dialog Box

2.

In the Site: field, type a name for the site.

3.

Click the Apply button.
The name of the configuration file appears in the Config: field; its name
is based on the system name; for example, /var/IRISconsole/.icrc.netwk1
is the configuration file for the site netwk1. The format of this
filename—.icrc.sitename— cannot be changed.
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4.

To save the new site configuration, select “Save IRISconsole Config” (or
“Save IRISconsole Config As...”) in the File menu in the main
IRISconsole window.

5.

To add another site, edit the entry in the Site: field or click the Reset
button to clear the field. After you click the Apply button, the name of
the new configuration file appears automatically in the Config: field.
Save the new site configuration as in step 4.

6.

When you are finished adding systems to the site, close the site window
by clicking the Close button.

7.

To save the file, select “Save IRISconsole Config” (or “Save IRISconsole
Config As”) in the File menu. The file is saved to the IRISconsole
directory /var/IRISconsole/.

8.

Click the Close button to exit the Change IRISconsole Config dialog box.

Note: You can rename or delete a site using choices in the IRISconsole main

window Edit menu.

13

Chapter 2: Configuring Sites

Checking the ST-1600 SCSI ID Number and Serial Ports
For installing systems for IRISconsole, you will need the number of the SCSI
ID used by the ST-1600. This number was set when the IRISconsole system
was installed and is displayed on the back of the ST-1600, as shown in
Figure 2-3. Note the number here:

1
2
3
9

4
10

5
11

6
12

7
13

8
14
15

6

7

45

01

16

23

SCSI ID
select switch

Figure 2-3

Checking the ST-1600 SCSI ID Number

Check the cabling for each system connected to the ST-1600 multiplexer to
determine the multiplexer port to which each system’s Remote System
Control and System Console ports are connected.
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If you want, fill in Figure 2-4 as an aid in determining which serial ports are
used for which servers. Table 2-1 shows examples.

CHALLENGE Server Hostname

Multiplexer Port Connection
Remote System Control

System Console

Figure 2-4

CHALLENGE Server Multiplexer Port Connections Form

Table 2-1

CHALLENGE Server Multiplexer Port Connections Form: Example

CHALLENGE Server Hostname

Multiplexer Port Number
Remote System Control

System Console

jupiter

01

02

zeus

03

04
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Adding a System to a Site
To add a system to a site, follow these steps:
1.

In the IRISconsole main window, double-click on the site to which you
want to add a system or select the system and select “Open Site...” in
the Operations menu. The site window opens, as shown in Figure 2-5.

Figure 2-5

2.

Site Window

In the site window, select “Add New System...” in the Edit menu. If
IRISconsole security is on, you are prompted for your password.
After you enter your password, the Change Site Config dialog box
appears, as shown in Figure 2-6.
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Figure 2-6

Change Site Config Dialog Box

3.

In the System Name: field, type the host name of the system you want
to add to this site.

4.

In the ST-1600 SCSI ID#: field, enter the SCSI ID number of the ST-1600,
as determined in the previous section, “Checking the ST-1600 SCSI ID
Number and Serial Ports.”

5.

Based on your observance of the ST-1600 cabling or using the entries in
Table 2-1, enter the ST-1600 port numbers to which cables to the
Console port and Remote System Control port are connected in the
Console Port# and Remote System Control Port# fields, respectively.

6.

In the Login: field, enter the login under which all operations requiring
access to the system via the network can be performed. This login is the
one used in the command
rsh <login>@<system> /usr/etc/sysctlrd -p

Note: The IRISconsole security login is separate from this system login;

IRISconsole security is explained in “IRISconsole Security” in Chapter 1.
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7.

In the Baud Rate: field, enter the baud rate at which this system sends
data to IRISconsole; the default for CHALLENGE systems is 9600. If
you enter a different baud rate, be sure that the CHALLENGE system
has been configured for that rate.

8.

Click the box at the Log Console Activity to File: if you want console
activity logged to a file in the /var/IRISconsole/logs/console_logs/ directory
that has the format systemname.<timestamp>.log. The format of this
filename cannot be changed.
Note: To view a log of a system’s console activity (“Spy Console” button
or command) or to view console activity logs (“View Console Logs”
button or command), this box must be checked when the system is
added to a site.

9.

When you are satisfied with the settings for this system, click the Apply
button to add this system to the site.

10. To save the configuration, select “Save Site Config” (or “Save Site
Config As...”) in the site window File menu.
11. To add another system to the site, edit the entries in the fields of the
Change Site Config dialog box, or click the Reset button to clear all
entries and begin entering again. Follow instructions in steps 3 through
10 for the new system.
12. When you are finished adding systems to the site, close the Change Site
Config dialog box by clicking the Close button.
If your hardware configuration changes, use “Modify System Config...” in
the site window Edit menu to change the parameters for a system in a site.
To delete a system from a site, select it in the site window and choose “Delete
Selected” in the Edit menu.
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Administering Sites

This chapter explains how to use the IRISconsole graphical user interface
(GUI) to administer servers and other devices in sites that it controls.
To see characteristics for a site, double-click on its name in the scrolling list
of sites in the IRISconsole main window. Alternatively, you can select a site
and then select “Open Site...” in the IRISconsole main window Operations
menu. Figure 3-1 shows an example site window.

Figure 3-1

Example IRISconsole Site Window
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This chapter explains
•

performing operations on attached systems

•

connecting to a remote system

•

monitoring attached systems

•

setting a threshold for and clearing an alarm

•

using a notify script

•

saving graph data to a file

Performing Operations on Attached Systems
You can use the buttons in the site window (see Figure 3-1) for system
administration tasks. All but the last of these options display a window in
which you type your IRISconsole login and password as it was entered in the
IRISconsole security facility; see “IRISconsole Security” in Chapter 1.
•

To access and display a system’s console window, select the system and
click the Get Console button. The console window appears on the Indy
workstation screen.

•

To generate a non-maskable interrupt (forcing a panic in the operating
system), click the Generate NMI button.

•

To reset a system in a site (hardware reset), select the system and click
the HW Reset button. A confirmation message appears.

•

To power-cycle a system, or to power on a system that has been turned
off, select the system and click the Power Cycle button.
In the case of a power cycle, the system controller removes the power
enable control signals, waits five seconds, and restores power. Boot
arbitration is started after power is reapplied.
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•

To take control of a system console that another user is currently using,
select the system and click the Steal Console button. The console
window appears on the Indy workstation screen. The original user sees
the message IRISconsole DINC closing...; that owner’s session is
killed.

•

To display a window showing console activity of a system in progress,
select the system and click the Spy Console button. In order to view this

Connecting to a Remote IRISconsole Workstation

activity, the “Log Console Activity to File” option must have been
checked when the system is added to a site, as explained in step 8 in
“Adding a System to a Site” in Chapter 2.
•

To view console logs (stored in /var/IRISconsole/logs/console_logs/), select
the system and click the Show Console Logs button. In order for these
logs to be written, an IRISconsole user must be connected via the “Get
Console” command and the system must have been configured with
the “Log Console Activity to File” option checked, as explained in step
8 in “Adding a System to a Site” in Chapter 2.

•

To display graphs of system activity, click the HW Status button. The
Hardware Status Monitor appears; this feature is explained in detail in
“Monitoring Attached Systems,” later in this chapter. This feature
requires a network connection between the Indy host and the target
system.

For each of these tasks, you can also select the corresponding command in
the Operations pulldown menu.

Connecting to a Remote IRISconsole Workstation
You can use ictelnet <Indyhostname> <portnumber> to access the IRISconsole
text-based menu from another system. ictelnet is a version of telnet adapted
for IRISconsole. Follow these steps:
1.

To configure a port on the Indy so that ictelnet communicates directly to
the IRISconsole application, edit the file /etc/services on that system to
include the following line, which specifies the port on which the service
is available:
ictelnet 5000/tcp # IRISconsole Remote Access service

For the port number, use any number between 5000 and 5063; the
number 5000 is recommended for the status port.
2.

Edit the file /etc/inetd.conf to include the line

ictelnet stream tcp

3.

nowait

root /usr/IRISconsole/bin/ictelnetd ictelnetd

To use ictelnet, type
ictelnet <Indyhostname> 5000
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4.

The software prompts for your IRISconsole login and password. Enter
them as they were entered with icpass -add icuser or icpass -add icadmin;
see “Adding an IRISconsole Administrator” in Chapter 1 for details.
After a few lines of response, the available IRISconsole sites configured
on the Indy are listed, for example:
Main Menu:
Available Sites
--------------1. eng1a
2. eng1b
3. eng1c
Enter choice (1 - 3) or ’q’ to Quit:

If a network connection from the remote host you are using to the
IRISconsole system is not available, you have two choices:

5.

•

log in to the IRISconsole system via modem and use ictelnet from
there

•

if you have a (modem) SLIP or PPP connection, you can run the
IRISconsole GUI remotely

Enter the number for the site to which you want to connect. Text like
the following appears:
Site ’eng1a’:
Available Systems
----------------1. eng1a
2. eng1b
3. eng1c
Enter choice (1 - 3) or ’..’ for Main Menu:

6.

Enter the number for the system to which you want to connect. The
Available Operations menu appears, for example:
System ’eng1a’:
Available Operations
-------------------1. Connect to Console
2. Hardware Reset
3. Generate NMI
4. Power Cycle
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5. Steal Occupied Console Line
Enter choice (1 - 5) or ’..’ for Systems Menu:

7.

Enter the number for the operation you want to perform. The following
message appears:
This operation is protected.
Please enter your IRISconsole login and password.
IRISconsole Login:

8.

Enter your IRISconsole login and password at the prompt. Status and
other information like the following appears:
------Connected Port=/dev/ttyd043 -----9600 BAUD 8 NONE 1 SWFC=ON HWFC=OFF
CAR=ON DTR=ON RTS=ON CTS=ON DSR=ON
Type ~? for Help, ~X to Exit.
Connection Ready.

9.

Use the tilde commands ((+-)Baud Csize Dtr Framing Hwfc Info
breaK Modem Oflush Parity Rts Swfc eXit) to change settings; you
need not press <Enter>.
For example, ~S (note that this letter is uppercase) toggles software flow
control and displays a message similar to:
9600 BAUD 8 NONE 1 SWFC=OFF HWFC=OFF
^^^^^^^^

10. To exit ictelnet, type ~X. This command returns you to the Available
Operations menu for the system that was described in step 6 of this
procedure.
11. From the Available Operations menu, type .. to exit to the Systems
Menu; type .. to exit to the Main Menu; type q to exit to the IRIX
prompt.
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Monitoring Attached Systems
Use the IRISconsole GUI to display information about attached systems. Via
the network connection, the IRISconsole gets hardware operating
information and displays it in windows or in real-time graphs in a window.
This section explains
•

using the Availability Monitor (Availmon) report for a system

•

displaying hardware inventory

•

displaying the syslog

•

displaying hardware status information

Using the Availability Monitor Report
The IRISconsole Availmon report gives a snapshot of availability
information on a system. It is a condensation of the information in
/var/adm/avail/availlog, displayed in a format similar to that of
/var/adm/avail/amreport.
To display the Availmon report, follow these steps:
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1.

Make sure that availmon is installed and active on the
CHALLENGE/Onyx systems you wish to access (use /etc/chkconfig).

2.

In the site window, select the system for which you want a report.

3.

Select “Availmon Report...” in the Monitor menu. A window like the
example in Figure 3-2 appears.

Monitoring Attached Systems

Figure 3-2

Example Availability Monitor Report

Displaying the Hardware Inventory of a System
To display a hardware inventory of an attached system, select the system in
the site window and click “Hardware Inventory...” in the Monitor menu. The
output of hinv for that system appears in a window.

Displaying the System Log
To display the syslog for a system, select the system in the site window.
Select “Show Syslog...” in the Monitor menu.
To update the syslog display, close the syslog window and select “Show
Syslog...” again.
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Displaying Hardware Status Information
To display hardware operating information on a CHALLENGE or Onyx
rackmount or deskside system in a site, follow these steps:
1.

In the IRISconsole main window, double-click on the site containing the
system whose hardware operating information you want to check. The
site window appears.

2.

In the Systems scrolling list of the site window, select the system for
which you want information.

3.

Click the HW Status button. The IRISconsole Hardware Status Monitor
appears, as shown in Figure 3-3.

Figure 3-3

Example IRISconsole Hardware Status Monitor

This section explains
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•

customizing the Hardware Status Monitor display

•

changing point and line styles for graphs

•

using graph control panels for specific graphs

Monitoring Attached Systems

Customizing the Hardware Status Monitor Display

To change the height of a graph in the IRISconsole Hardware Status Monitor,
put the mouse cursor on one of the two sashes (small square at the extreme
right between the graphs) and drag it down or up; the relative heights of the
graphs above and below it change.
To zoom an area of the display, select the graph you want to zoom; holding
down the <Ctrl> key and pressing the middle mouse button, move the
mouse. Press r to reset the display.
You can further customize the display using choices in the Hardware Status
Monitor View pulldown menu. Figure 3-4 shows the View menu.
View
Display a log showing alarm thresholds that were exceeded

Alarms Log
Voltage Graph

Turn specific graph displays off and on

Display legends that label the line types in the graph

Figure 3-4

Ctrl+V
Temperature Graph Ctrl+T
Blower Graph
Ctrl+B
Legends

View Pulldown Menu
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Finally, you can use the Global Controls dialog box to customize the graph
data. Select “Global Controls...” in the Options pulldown menu; Figure 3-5
shows this dialog box.

For all graphs:
Set to
fastest rate
Optimize
scrollback

Set sampling rate for data
Set percentage of graph to scroll
back when limit is reached
Set number of points displayed onscreen
(amount of graph that is offscreen to the left)

Start escall program when threshold is exceeded
Run notify script when threshold is exceeded
Sound beep or tone when threshold is exceeded
Enter message in log file
when threshold is exceeded

Figure 3-5

Global Controls Dialog Box

The Start ‘escall’ feature in Alarm Actions is available only for sites in North
America that have purchased the Support Advantage Electronic Services
package.
Changing Point or Line Styles for Graphs

To change the point or line style in a graph display, follow these steps:
Note: Style changes apply onscreen and for printing only; point and font

style changes are not saved when the graph is saved to a file.
1.
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In the Selected menu, select “Styles...” or click the Styles button in the
Graph Control dialog box. Figure 3-6 shows the Graph Style dialog box.

Monitoring Attached Systems

Figure 3-6

Graph Style Dialog Box

2.

In the Hardware Status Monitor, click the left mouse button on the
graph whose style you want to change. The graph background turns
yellow.

3.

Put the mouse cursor on the line whose style you want to change and
click the right mouse button.
Note: To facilitate selecting a line, zoom the display by holding down
the <Ctrl> key, pressing the middle mouse button, and moving the
mouse. To reset the display, type r.

4.

In the Graph Style dialog box, select the point or line style you want
and click the Apply button to save the setting.

5.

When you are satisfied with the settings, click the Close button to exit
the Graph Style dialog box.
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Using Graph Control Panels for Specific Graphs

A graph control panel is associated with each graph. To display the control
panel for a graph, follow these steps:
1.

In the Hardware Status Monitor, select the graph for which you want to
display a control panel. The graph background turns yellow.

2.

In the Selected menu, select “Graph Controls...” Figure 3-7 shows the
graph control panel for blower speed(s).

Determine whether the selected graph displays live data
Set data density for the selected graph
Set high and low threshold values for an alarm

Display Global Controls dialog box

Figure 3-7

Graph Control Panel for Blower Speed

Use features of this panel to
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•

set an alarm threshold, as described in “Using Alarms,” later in this
chapter

•

set actions to be performed if the threshold is exceeded, as described in
“Using Alarms,” later in this chapter

•

clear an alarm

•

change the point and line style of the graphs, as described in “Changing
Point or Line Styles for Graphs,” earlier in this chapter

•

print the graphs, as described in “Saving Graph Data to a File,” later in
this chapter

•

save the graphs as graphs or PostScript® files, as described in “Printing
a Graph,” later in this chapter

Using Alarms

Using Alarms
You can set a threshold value for a hardware operating parameter, such as
blower speed. When the value is exceeded, the graph that maps it changes
color to alert you that the threshold has been exceeded and its contents are
saved to a file. You can also set IRISconsole to perform any of the following
actions when the threshold is exceeded:
•

start the escall program (Electronic Services Call Monitor), which is
included in the Support Advantage Electronic Services package

•

cause a beep or tone to be sounded

•

enter a message in an alarms log file in /var/IRISconsole/logs/; the default
filename is alarms.log

•

start a notify script

For example, you can set the operating temperature threshold for a
CHALLENGE XL in a site to 37, so that when the system internal
temperature exceeds 37 degrees C, the alarm is triggered.
This section explains
•

setting a threshold for an alarm

•

clearing an alarm

•

viewing an alarm graph file

•

using a notify script

Setting a Threshold for an Alarm
To set a threshold, follow these steps:
1.

Select the graph for which you want to set an alarm threshold. The
graph background turns yellow.

2.

In the Selected menu, choose “Graph Controls...” The Graph Control
Panel appears; Figure 3-8 shows the panel for the Temperature graph.
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Figure 3-8

Graph Control Panel for Temperature

3.

If desired, change the data density (number of points) of the data being
sampled.

4.

Select the high and low alarm threshold values you want from the
choices in the High and Low fields.

5.

If desired, select one or more alarm actions in the Global Controls
window.

When the threshold value is reached or exceeded, the graph display turns
hot pink when unselected (bright red when selected).

Clearing an Alarm
To clear an alarm, select the graph whose alarm you want to clear and click
the Clear Alarm button in the Graph Control panel, or select “Clear Alarm”
in the Selected menu. To clear all alarms, select “Clear All Alarms” in the
Options menu.

32

Using Alarms

Viewing an Alarm Graph File
When a threshold is exceeded, the graph for which the alarm is set is
automatically saved to a file in the directory /var/IRISconsole/logs/alarms/. The
filename has the format graphname.<timestamp>.xrt; for example,
voltage.951231.1144.0.xrt.
You can view alarm graph files by selecting “Display Saved Graph...” in the
IRISconsole Hardware Status Monitor File menu; see “Displaying a Graph
File,” later in this chapter.

Using a Notify Script
An option in the Global Controls window enables IRISconsole to run a
script—/var/IRISconsole/adm/scripts/icnotify.tclX—when an alarm threshold is
exceeded. This script, which was written in tclX (extended tcl), is
self-documenting.
To edit this script, select “Edit Operator Notify Script” in the main window
Options window. You must be root to edit this script.
For example, to cause an alarm threshold to send an e-mail message to a
specified user, enter e-mail address(es) in the curly braces in the line
set OPERATORS { }

You can edit icnotify.tclX to include other scripts.
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Saving Graph Data to a File
You can save a graph to a PostScript file or image file to send to service
personnel, or to compare with other graph data saved to files.
To save a graph to a PostScript file, click the Save As PS... button in the Graph
Control panel. Enter a filename and click the Save button to save the file and
exit the dialog box.
To save a graph to an image file, follow these steps:
1.

Freeze the data by clicking the Live Data Feed checkbox off in the
Graph Control panel (see Figure 3-7 or Figure 3-8). The scrollbars under
the graphs are activated.

2.

Click the Save As Graph button in the Graph Control panel. A file
selection dialog box appears, as shown in Figure 3-9.

Figure 3-9

Saving a Graph File

If desired, click the Filter button to display a dialog box in which you
can exclude filename patterns to restrict the filenames displayed.
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3.

Enter a filename for the graph file in the Selection field.

4.

Click the Save button to save the file and exit the dialog box.

Displaying a Graph File

Displaying a Graph File
You can display the saved graph in IRISconsole by selecting “Display Saved
Graph...” in the IRISconsole Hardware Status Monitor File menu. A dialog
box similar to that shown in Figure 3-9 appears, in which you select the file
to display. Files saved as graphs appear when they are selected; display files
saved as PostScript files in your PostScript viewer.

Printing a Graph
You can print a graph as it is displayed in the Hardware Status Monitor.
To print the contents of a graph in the Hardware Status Monitor, follow these
steps:
1.

In the Hardware Status Monitor, select the graph you want.

2.

If desired, change the dimensions of the graph by moving a sash (small
square at the extreme right between the graphs).

3.

If desired, select an area of the display by holding down the <Ctrl> key
and pressing the left mouse button; zoom the selection by moving the
middle mouse button. (Press r to reset the display.)

4.

When the screen displays the graph as you want it to be printed, click
the Print button. In the Print dialog box, select the print options you
want.
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Appendix A

A.

Error Messages and Warning Messages

This appendix lists error messages that can appear during operation of
IRISconsole. It interprets each error message and suggests solutions. The
messages are listed in alphabetical order.
Note: For CHALLENGE and Onyx system error messages and system event

messages, see Appendix C in the Deskside POWER CHALLENGE and
CHALLENGE L Owner’s Guide and Appendix C in the POWER CHALLENGE
and CHALLENGE XL Rackmount Owner’s Guide.
<name> is a directory

You selected a directory to save into, when a file was
expected.
A site edit session is in progress.
Finish that before opening.

It is not possible to open a site while its configuration
information is being edited. Finish the editing first.
Cannot create directory <name>

Cannot create directory; permissions on /var/IRISconsole
should be writable by the user.
Cannot edit multiple configurations.

You have selected more than one site or system. Select one
site or system at a time to edit.
Caution: Baud rate of a Challenge machine is typically 9600.
Make sure that it is configured to handle this rate.

A legal value other than 9600 was entered in the Baud Rate:
field of the Change Site Config dialog box. Although the
baud rate can range from 300 to 115,200, any rate other than
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the default rate of 9600 needs configuration changes in the
managed CHALLENGE server to accept that rate. Note that
this messages is a warning and not an error message.
Couldn’t find an ST-1600 attached to SCSI bus.

IRISconsole couldn’t detect any ST-1600s that should have
been attached to a SCSI port on the back of the Indy
workstation. Follow these steps:
1.

Check the SCSI target ID on the back of the ST-1600;
make sure that it does not conflict with any other
external devices that are attached. Do not use the
settings 0 or 1.

2.

Check the connections of the SCSI cable between the
ST-1600 and the Indy SCSI port. Use the High Density
SCSI-2.cable supplied with the ST-1600 or another
cable meeting specifications outlined in the Technical
Specifications chapter of the IRISconsole ST-1600
Multiplexer Installation Guide.

3.

After checking and, if necessary, reseating connectors,
ask IRISconsole to rescan by selecting “Show SCSI Bus
Attachments” in the Options menu of the main
IRISconsole window. This action displays the SCSI IDs
of all ST-1600 multiplexers that IRISconsole finds.

Electronic Services’ Call Logging Facility (escall) is not
installed.

You have initiated an action that requires use of escall. The
escall program is not included in the IRISconsole package; it
is available only for sites in North America that have
purchased the Support Advantage Electronic Services
package. Contact your Sales Engineer for more information.
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Error in getting Hardware Inventory.
Either the target system could not be reached, or
it’s refusing service to the Login ‘login’

You tried to run hinv on a system in a site. Either the target
system could not be reached, or it is refusing service to your
login. Follow these steps:
1.

Check the network connection with the target system
(ping or another command as appropriate).

2.

Check the login you have entered for that system:
select the system and choose “Modify System Config”
in the Edit menu of the site window.

3.

Make sure that the login you entered has permission to
perform a remote operation by typing
rsh <login>@<system> /sbin/hinv

If necessary, correct the login (or get its permissions
changed) and retry the command above.
Error in ST-1600 software installation
Couldn’t find /sbin/cdscanbus

The ST-1600 software subsystem has not been installed.
Install it from the distribution CD.
Failed to create config file

You have attempted to create a new site. Check the
permissions on /var/IRISconsole to see if it is writable for
your login.
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Failed to fetch /var/adm/SYSLOG: <reason>

The system has probably refused service to your login.
Follow these steps:
1.

Check the login you have entered for that system:
select the system and choose “Modify System Config”
in the Edit menu of the site window.

2.

Make sure that the login you entered has permission to
perform the operation by typing
rsh <login>@<system> /bin/tail /var/adm/SYSLOG

If necessary, correct the login (or get its permissions
changed) and retry the command above.
Failed to write to file

Your attempt to save the configuration file failed. Check
permissions on /var/IRISconsole/.icrc.sitename to see if it is
writable for your login.
Invalid baud rate:
Should be between 300 and 115200.

An inappropriate baud rate was entered. Baud rates can
range between 300 and 115200.
Invalid field value <value>

The value you entered in this field of the Change Site Config
dialog box is invalid; try again.
Invalid System Console port number
Invalid Remote System Control port number

ST-1600 port numbers may range only from decimal 1 to 16.
Must select a site.
Must select a system.

An attempt was made to perform an operation on a site or
system without actually selecting it. Single-click on the
desired site or system first and try the action again.
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No Availability Monitor information to report.
Either <system> doesn’t have an ‘availmon’ running, or
it’s refusing service to the Login <login>

Either the currently selected doesn’t have an availmon
running, or it is refusing service to your login. Check the
login you have entered for that system: select the system
and choose “Modify System Config” in the Edit menu of the
site window. If necessary, correct the login (or get its
permissions changed) and retry the operation.
The System Availability Monitoring Facility (availmon) is
included in the eoe2.sw subsystem and must be installed on
the CHALLENGE server. After it is installed, activate it by
typing /etc/chkconfig avail on.
No icons may be dropped into this panel.

This version of IRISconsole does not support drag and drop
behaviors on icons. The icon(s) dropped will automatically
be repositioned at their original locations.
No Remote System Control information to report.
Either <system> doesn’t have a ‘sysctlrd’ running, or
it’s refusing service to the Login <login>

Either the currently selected system doesn’t have a sysctlrd
running, or it is refusing service to your login.
If the connected system is a CHALLENGE S, you cannot
perform the action you tried; this type of server has no
system controller, which is required for this action.
For other connected systems, follow these steps:
1.

Check the login you have entered for that system:
select the system and choose “Modify System Config”
in the Edit menu of the site window.

2.

Make sure that the login you entered has permission to
perform the operation by typing
rsh <login>@<system> /usr/etc/sysctlrd -p

If necessary, correct the login (or get its permissions
changed) and retry the command above.
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Nothing selected.

You have specified an action for which a site or system must
be selected. Select the item and try the action again.
Null input values aren’t allowed.
Spaces not allowed in fields.

Enter a valid value in the field.
Null site name.
Null system name.

An attempt was made to create a site or system with a “null”
name. Names must have at least one character and may not
contain spaces.
Please close following site(s) before deleting

You attempted to delete a set of sites when a subset of it was
still open. Close the site(s) and try the action again.
Port number must be between 1 and 16.

ST-1600 port numbers may range only from decimal 1 to 16.
Rename not allowed when site is open.

An attempt was made to rename a site that is already open.
Close the site first.
SCSI ID must be between 2 and 7.

Inspect the back of the ST-1600 for the SCSI target ID used.
To verify that the ST-1600 is installed properly, select “Show
SCSI Bus Attachments” in the Options menu of the main
IRISconsole window and check the SCSI ID displayed in the
dialog box.
Site is already open.

An attempt was made to open a site that is already open.
The site window appears at the top of the stack of windows.
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Site name already exists.
Select it, then “Edit” its configuration.

An attempt was made to create a site that exists already.
Create a unique site with a new name. To change the
configuration of an existing site, select it first.
Spaces not allowed in fields.

Enter a valid value in the field.
System name already exists.
Select it, then “Edit” its configuration.

An attempt was made to create a system that exists already.
Create a unique system with a new name. To change the
configuration of an existing system, select it first.
/usr/sbin/sysmon not installed.

sysmon.sw, included in the base IRIX release, is a GUI-based
tool for analyzing syslogs. Install this system from the IRIX
5.3 with XFS CD for this feature to function.
You must have eoe2.sw.uucp installed.

IRISconsole uses uucp-style locking on device nodes. Install
this subsystem from the IRIX 5.3 with XFS CD.
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CHALLENGE/Onyx system, 1
ports, 1
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D
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E
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escall
not installed, 38
Start ‘escall’ feature availability, 28
starting, 31
/etc/services, editing for ictelnet, 21

G
Generate NMI, 20
and security, 4
Get Console, 20, 21
and security, 4
Global Controls dialog box, 28
graph
control panel, 30-33
displaying file, 35
printing file, 35
saving data to file, 34
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and IRISconsole security login, 17
security, 5, 6

H
hardware inventory (hinv output), 25
hardware status information, 26-30
Hardware Status Monitor, 26-27
changing display, 27-29
View menu, 27
hinv
output, 25
problem, 39
HW Reset, 20
and security, 4
HW Status, 21, 26

I
icnotify.tclX, 33
.icrc.sitename, 12
problem writing to, 40
ictelnet, 21-23
IRISconsole
access to remote systems, 1, 11
connecting to remote, 21-23
hardware requirements, 3
monitoring attached systems, 24-30
operation, 8-9
security, see security
security login and system login, 17

L
Log Console Activity to File, 21
log file
alarms, 31
for system activity, configuring, 18
login
configuring, 17
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N
non-maskable interrupt, generating, 20
notify script, 33

P
password
changing, 6-7
security, 5, 6
Power Cycle, 20
and security, 4
printing graph file, 35

R
remote access, 21-23
login and password, 23
Remote System Control port, 1
and ST-1600 port number, 14
configuring, 17
invalid number, 40
problem getting information, 41

S
saving graph as file, 34
security, 4-8
adding administrator, 5
adding user, 5-6
changing password, 6-7
deleting administrator or user, 7
determining if off or on, 5
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login, 5, 6
and remote access, 23
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protected features, 4
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administering, 19-35
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Spy Console, 20
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ST-1600, ix, 1
port number, 14
problem, 38
SCSI ID
checking, 14
configuring system, 17
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Steal Console, 20
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system
adding to site, 16-18
administration, 20-21
see also IRISconsole, monitoring attached systems
System Console port, 1
and ST-1600 port number, 14
system log (syslog), 25
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V
/var/IRISconsole/adm/scripts/icnotify.tclX, 33
/var/IRISconsole and config file, 39
/var/IRISconsole/logs/, 31
View menu, 27

U
/usr/sbin/sysmon problem, 43
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